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TI Designs 

EtherCAT® Interface for High Performance C2000™ MCU 

 
Design Overview 

This reference design demonstrates how to connect 
an EtherCAT® ET1100 Slave Controller to a 
C2000™ Delfino MCU.  The interface supports both 
demultiplexed address/data busses for maximum 
bandwidth and minimum latency and a SPI mode for 
low pin-count EtherCAT communication.  The Slave 
Controller offloads the processing of 100Mbps 
Ethernet-based fieldbus communication, thereby 
eliminating CPU overhead for these tasks.  
 
Design Resources 

TIDM-DELFINO-ETHERCAT     Design Folder 

TMS320F28377D  Product Folder 

TLK105  Product Folder 

LAUNCHXL-F28377S  Tools Folder 

 
Block Diagram 

TMS320F2837x

Beckhoff ET1100

TLK105

RJ45

TLK105

RJ45

Mux
DC/DC
5/3.3V

Design Features 

 High-Performance Real-time Control MCU 
paired with low-latency Ethernet-based 
communication 

 High-bandwidth, low-latency interface to 
Beckhoff ET1100 EtherCAT Slave Controller 

 Supports both asynchronous parallel and 
SPI connections 

 Glueless interface 

 Eliminates CPU overhead for EtherCAT 
frame processing 

 
Featured Applications 

 Industrial Drives 

 Servo Motor Drives 

 Manufacturing Robotics 

 CNC Machinery 

 Remote I/O 
 
Board Image 

 
 

  

http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
http://www.ti.com/product/tms320f28377D
http://www.ti.com/product/TLK105
http://www.ti.com/tool/LAUNCHXL-F28377S
http://www.ti.com/tool/designdrive
http://www.ti.com/tool/designdrive
http://www.ti.com/tool/designdrive
http://www.ti.com/tool/designdrive
http://www.ti.com/tool/designdrive
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1 System Description 

The TIDM-DELFINO-ETHERCAT is an add-on card that incorporates a Beckhoff ET1100 EtherCAT™ Slave 
Controller (ESC) and TI Ethernet PHYs that allows the creation of EtherCAT slave nodes when coupled 
with a C2000 MCU.  Multiple board and interface options are supported, which includes asynchronous 
parallel and SPI interfaces for both TI F2837x ControlCARDs and C2000 LaunchPad Development Kits.  
 
This TI Design illustrates how to set up the EtherCAT BoosterPack™ Plug-in module and/or ControlCARD 
add-on board, initialize the ET1100 subsystem for first use, and install and configure the Beckhoff 
TwinCAT 3 software for use as an EtherCAT master in a test setup. Example code is provided to configure 
both SPI and EMIF interfaces and run simple read/write tests across an EtherCAT network. 
 

 
Figure 1. TIDM-DELFINO-ETHERCAT BoosterPack Plug-in Module and C2000 Launchpad 
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1.1 TMS320F28377D 

The Delfino TMS320F2837x is a powerful 32-bit floating-point microcontroller unit (MCU) designed for 
advanced closed-loop control applications such as industrial drives and servo motor control; solar 
inverters and converters; digital power; transportation; and power line communications. Complete 
development packages for digital power and industrial drives are available as part of the powerSUITE and 
DesignDRIVE initiatives. The F2837x supports a new dual-core C28x architecture that significantly boosts 
system performance while integrated analog and control peripherals allow designers to consolidate 
control architectures and eliminate multiprocessor use in high-end systems. 
 
In the TIDM-DELFINO-ETHERCAT design, the F2837x receives EtherCAT data from the ET1100 through 
either a serial (SPI) interface or an asynchronous parallel memory interface (EMIF). The figure below 
shows the use of EMIF2, but either EMIF can be used to interface to the ET1100.  Note that GPIO93,94 
are for future expansion to address a larger memory space. They are not used in the example code. 
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Figure 2. TMS320F2837x EMIF interface to ET1100 EtherCAT Slave Controller 
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Figure 3. Delfino SPI as EtherCAT PDI 

 
 

http://www.ti.com/product/TMS320F28377D
http://www.ti.com/lsds/ti/microcontrollers_16-bit_32-bit/c2000_performance/real-time_control/applications.page#drives
http://www.ti.com/lsds/ti/microcontrollers_16-bit_32-bit/c2000_performance/real-time_control/applications.page#solar
http://www.ti.com/lsds/ti/microcontrollers_16-bit_32-bit/c2000_performance/real-time_control/applications.page#solar
http://www.ti.com/lsds/ti/microcontrollers_16-bit_32-bit/c2000_performance/real-time_control/applications.page#digi
http://www.ti.com/lsds/ti/microcontrollers_16-bit_32-bit/c2000_performance/real-time_control/applications.page#transportation
http://www.ti.com/lsds/ti/microcontrollers_16-bit_32-bit/c2000_performance/real-time_control/applications.page#plc
http://www.ti.com/tool/powersuite
http://www.ti.com/tool/designdrive
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1.2 TLK105 

The TLK10x is a single-port Ethernet PHY for 10Base-T and 100Base TX signaling. This device integrates all 
the physical-layer functions needed to transmit and receive data on standard twisted-pair cables. The 
TLK10x supports the standard Media Independent Interface (MII) and Reduced Media Independent 
Interface (RMII) for direct connection to a Media Access Controller (MAC).  

1.3 TPS62063 

The TPS6206x is a family of highly efficient synchronous step-down DC-DC converters. They provide up to 
1.6-A output current. With an input voltage range of 2.7 V to 6 V, the device is a perfect fit for power 
conversion from 5-V or 3.3-V system supply rails. The TPS6206x operates at 3-MHz fixed frequency and 
enters power save mode operation at light load currents to maintain high efficiency over the entire load 
current range. The power save mode is optimized for low output voltage ripple. For low noise 
applications, the device can be forced into fixed frequency PWM mode by pulling the MODE pin high. 
 
In this TI Design, the converter enables power to be supplied from either the C2000 LaunchPad,  
controlCARD, or from an external 5V source. 

1.4 SN74LVC1G07 

This single buffer/driver is designed for 1.65-V to 5.5-V Vcc operation. The output of the SN74LVC1G07 
device is open drain and can be connected to other open-drain outputs to implement active-low wired-
OR or active-high wired-AND functions. The maximum sink current is 32 mA.  
 
In this design, the open-drain buffer connects a GPIO from the F2837x LaunchPad or controlCARD to the 
ET1100 EtherCAT slave controller reset pin, thereby enabling independent reset of both devices. 
 

1.5 SN74CBTLV3245A 

The SN74CBTLV3245A provides eight bits of high-speed bus switching in a standard '245 device pinout. 
The low on-state resistance of the switch allows connections to be made with minimal propagation delay. 
The device is organized as one 8-bit switch. When output enable (OE) is low, the 8-bit bus switch is on, 
and port A is connected to port B. When OE is high, the switch is open, and the high-impedance state 
exists between the two ports.  
 
In this TI Design, the bus switch isolates selected ET1100 outputs from the F2837x controlCARD GPIOs 
when the EMIF interface is not used (SPI mode).  Note that the bus switches are optional in a design using 
only a single interface type. 
  

http://www.ti.com/product/TLK105
http://www.ti.com/product/TPS62063
http://www.ti.com/product/SN74LVC1G07
http://www.ti.com/product/SN74CBTLV3245A
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1.6 SN74CBTLV3257 

The SN74CBTLV3257 device is a 4-bit 1-of-2 high-speed FET multiplexer/demultiplexer. The low on-state 
resistance of the switch allows connections to be made with minimal propagation delay. The select (S) 
input controls the data flow. The FET multiplexers/demultiplexers are disabled when the output-enable 
(OE) input is high.  
 
This multiplexer connects selected GPIOs to the ET1100 depending on the interface mode (EMIF or SPI). 
Note that the multiplexer is optional in a design using only a single interface type. 

1.6.1 Beckhoff ET1100 EtherCAT Slave Controller (ESC) 

The ET1100 device is an EtherCAT Slave Controller (ESC).  It handles all communications between the 
EtherCAT fieldbus and the F2837x interface (either SPI or EMIF).  
 
See the Beckhoff website for more details.  http://www.beckhoff.com 
  

http://www.ti.com/product/SN74CBTLV3257
http://www.beckhoff.com/
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2 Block Diagram 

Figure 4 shows the block diagram of the SPI (for the C2000 LaunchPad) and EMIF (for the C2000 
ControlCARD) interfaces.   In both configurations, the ‘F2837x runs the EtherCAT slave stack while the 
ET1100 is used to offload the EtherCAT Slave Controller (ESC) frame processing, FMMU, and 
SyncManager operations. 
 
Certain pins on the ET1100 are used on both the SPI and asynchronous interfaces, which thus requires 
the ‘74CBTLV3257 mux and ‘74CBTLV3245 buffer to steer these signals to the appropriate GPIO on the 
‘F2837x MCU.  
 
The EtherCAT BoosterPack  and Add-on cards feature an on-board DC-DC 5V-3.3v converter, which allows 
the 3.3v Vcc to be sourced from either the C2000 LaunchPad/ControlCARD, or generated locally from an 
off-board 5V source. 
   

 
 

Figure 4. ‘F2837x SPI and EMIF connections to the EtherCAT Slave Controller 
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2.1 Highlighted Products 

2.1.1 TMS320F2837x Delfino Microcontroller Functional Diagram 

 

 
 

Figure 5. TMS320F2837x Functional Diagram 

 
Ref: TMS320F2837x Datasheet, Figure 1-1. 

  

http://www.ti.com/lit/sprs880


 
www.ti.com 

 

 TIDUBQ6 - April 2016 EtherCAT® Interface for High Performance C2000™ MCU 8 
 

Copyright © 2016, Texas Instruments Incorporated 

 

2.1.2 TLK105 Ethernet PHY Functional Diagram 

Ref: TLK105 Datasheet, http://www.ti.com/lit/ds/symlink/tlk105.pdf , Figure 1-1. 
 

 
Figure 6. TLK105L Functional Diagram  

http://www.ti.com/lit/ds/symlink/tlk105.pdf
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2.1.3 SN74CBTLV3245A Functional Diagram 

Ref: SN74CBTLV3245A datasheet, http://www.ti.com/lit/ds/symlink/sn74cbtlv3245a.pdf , Logic Diagram 
(Positive Logic) 
 

 
Figure 7. SN74CBTLV3245A Functional Diagram 

2.1.4 SN74CBTLV3257 Functional Diagram 

Ref: SN74CBTLV3257 functional diagram, 
http://www.ti.com/general/docs/datasheetdiagram.tsp?genericPartNumber=SN74CBTLV3257&diagramI
d=SCDS040K , fbd_scds040k.gif 
 
 

 
 

Figure 8. SN74CBTLV3257 Functional Diagram 

2.1.5 ET1100 Functional Diagram 

Diagram available on the Beckhoff website: http://www.beckhoff.com 
   
 http://download.beckhoff.com/download/document/io/ethercat-development-
products/ethercat_et1100_datasheet_v1i9.pdf 
  

http://www.ti.com/lit/ds/symlink/sn74cbtlv3245a.pdf
http://www.ti.com/general/docs/datasheetdiagram.tsp?genericPartNumber=SN74CBTLV3257&diagramId=SCDS040K
http://www.ti.com/general/docs/datasheetdiagram.tsp?genericPartNumber=SN74CBTLV3257&diagramId=SCDS040K
http://www.beckhoff.com/
http://download.beckhoff.com/download/document/io/ethercat-development-products/ethercat_et1100_datasheet_v1i9.pdf
http://download.beckhoff.com/download/document/io/ethercat-development-products/ethercat_et1100_datasheet_v1i9.pdf
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3 Key System Specifications 

 
Table 1 . EMIF Configuration and timing settings for ET1100 PDI 

 
Parameter Description Value Delay* 

TA Read-to-Write Turnaround time 1 5 ns 

RHOLD Address and CSn hold after OEn LH edge 1 5 ns 

RSTROBE Read Strobe time in units of EMIF Clocks 64 320 ns 

RSETUP Address and CSn to OEn assertion delay 1 5 ns 

WHOLD Write Hold time after WE deassertion 1 5 ns 

WSTROBE Write Strobe (WE) width 2 10 ns 

WSETUP Address and CSn setup time to WE assertion 1 5 ns 

EW Extended Wait Mode ENABLE - 

SS Strobe Select Mode DISABLE - 

 
* For the given F2837x system with Fsysclk = 200 MHz 
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Figure 9. EMIF PDI Timing Diagram 
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4 Getting Started Hardware 

This TI-Design describes two configurations for the EtherCAT Add-on board: a BoosterPack form factor 
compatible with TI LaunchPad Development kit, and an add-on card for F2837x ControlCARDs. The 
hardware setup described below is identical for both configurations in terms of EtherCAT connectivity 
and slave operation. The available Process Data Interfaces (PDIs) differs between the two boards, in that 
the LaunchPad has only enough pins ofr a SPI connection, whereas the controlCARD Addon has sufficient 
pins for either an EMIF or SPI interface. For the sake of simplicity, only the C2000 LaunchPad + 
BoosterPack configuration is covered here. 
 

 
Figure 10. Stacked F2837x LaunchPad and EtherCAT BoosterPack 

 

 
 

Figure 11. EtherCAT Test Setup 

 

4.1 EtherCAT Master Configuration using TwinCAT3 

4.1.1 Download and Install TwinCAT3 from the Beckhoff website 

The TwinCAT3 software is available from the Beckhoff website at http://www.beckhoff.com.  Follow the 
left sidebar to Download -> Software -> TwinCAT 3 -> TE1xxx | Engineering. The most recent version of 
this software as of this writing is TwinCAT 3.1 – eXtended Automation Engineering (XAE) v 3.1.4018.26. 
  

http://www.beckhoff.com/
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4.1.2 Verify the TwinCAT Runtime is active 

1. Check for the EtherCAT icon in the notification panel in the lower-right corner as shown 
below.  If this is absent, open the notification panel  and check in the popup window for the 
TCSwitchRuntime.  Right-Click this icon and select Tools->TCSwitchRuntime  

 
Figure 12. TwinCAT Runtime icon in Windows Toolbar 

 
2. Verify that the TCSwitch Runtime is active.  The “Deactivate” button should be showing as 

illustrated in the picture below.  If this button reads “Activate”, the click that button to start 
the TCSwitchRuntime. 

 

 
Figure 13. TwinCAT Runtime Dialog box. 

 
3. If the TCSwitchRuntime is not found in step (a,b) above, then locate the runtime in the file 

system.  A typical location is: “c:\TwinCAT\TcSwitchRuntime\TcSwitchRuntime.exe”. 
Note that it is NOT commonly found in the Start Menu.  
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4.1.3 Start TwinCAT3 and verify that TwinCAT is running in Visual Studio 

1. Locate the TwinCAT XAE, which can be found in 1 of 3 places 
a. Start menu – under Beckhoff-> TwinCAT3 – TwinCAT XAE (VS 2010) 
b. Desktop icon - 

Figure 14. TwinCAT3 XAE Desktop icon 

 
c. Notification panel icon – Rt-click and select TwinCAT XAE (VS 2010) 

 

Figure 15. TwinCAT3 icon in toolbar 
 

2. Verify that TwinCAT is running under Visual Studio.  “TwinCAT” and “PLC” should both appear in the 
main toolbar (circled below).  If these menu items are not shown, then the TC3 runtime is NOT 
running- Go back to step 1 to restart the TC3 runntime. 
 

Figure 16. Visual Studio Menus for TwinCAT3 
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3. Open a new EtherCAT project  
a. File -> New -> Project 

 

Figure 17. TwinCAT3 New Project Dialog 

 
4. Verify that a Realtime Ethernet Adapter is installed 

a. TwinCAT – Show Realtime Ethernet Compatible Devices 
If no RT adapter is installed, select one from the list of Compatible devices and click “Install”, then exit 

this popup. 
 

  
Figure 18. TwinCAT3 EtherNet Adapter Dialog 
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5. Scan for the newly installed Realtime adapter by clicking TwinCAT -> Scan 
a. A popup indicating TwinCAT has found the adapter should appear 

 

Figure 19. TwinCAT3 Discovery of Ethernet Adapter 

 
b. Click “OK”, then click “Yes” to the following two popups 

 

 
Figure 20. TwinCAT3 Master Scan for Slaves and Free Run Activation 
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c. The screen view below should now be visible in TwinCAT3, indicating that the Master and Slave 
are connected and prepared for use. Note that “Box 1 (TI_C2kESC)” appears at the bottom of the 
image, indicating that TwinCAT has discovered the EtherCAT slave.  If this is the first time that the 
slave has been connected and the EEPROM has not yet been programmed, the “Box n ()” label 
(i.e. “TI_C2KESC”) will not be visible. 
 

Figure 21. TwinCAT solution Explorer showing EtherCAT Master (Device 2) and Slave (Box1, TI_C2kESC) 

 
 
 
The EtherCAT Master is now ready for communication with the Slave Device. 
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4.2 Configuring the EtherCAT BoosterPack interface for EMIF or SPI operation 

The EtherCAT BoosterPack board must be configured prior to powerup to select between the EMIF or SPI 
interface from the C28x to the ET1100 slave controller.  Options for power source and interface type are 
available through jumpers and/or DIP switches as described in the Figure and Table below. 
 

 
 

Figure 22. EtherCAT BoosterPack LED and Switch Locations 

 
Table 2 . EtherCAT BoosterPack LED and Switch Usage Descriptions 

 

Name Options Description 

Switches/ Jumpers 
SW1 L – SPI 

R – EMIF 
Selects between EMIF and SPI Interface Modes 

J3 1-2 Off-board   
 
2-3 On-board  

Off-board: 3.3v is provided directly from attached LaunchPad or 
ControlCARD 
On-board: 3.3v is generated by the on-board regulator from a separate 
                    5V supply. 

J10  
1-2 On-board 
2-3 Off-board 

VCC_5V source: 
On-board: 5V provided by LaunchPad or ControlCARD 
Off-board: 5V provided externally through header J9. 

LEDs 
RUN LED State Machine 

Status* 
Off: ET1100 Device is in INIT state. 
On: ET1100 Device is in Operational state. 

DS2/PWR 
LED 

3.3v Power ON indicates 3.3v is being supplied to the board. 
See the schematics in Figure 38 for details. 

 
* Reference: Additional RUN LED States given in Table 54 of the ET1100 datasheet at:  
http://download.beckhoff.com/download/document/io/ethercat-development-
products/ethercat_et1100_datasheet_v1i9.pdf  

http://download.beckhoff.com/download/document/io/ethercat-development-products/ethercat_et1100_datasheet_v1i9.pdf
http://download.beckhoff.com/download/document/io/ethercat-development-products/ethercat_et1100_datasheet_v1i9.pdf
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4.3 Preparing the Addon board for EtherCAT communcation using TwinCAT3 

 
After installing the TwinCAT3 software in the  previous section and verifying connectivity between the 
EtherCAT Master and the slave node, the ESC EEPROM must be programmed to enable communication 
to the C28x device over either the EMIF or SPI PDI (Process Data Interface).  The procedure given below 
writes the binary file associated with the selected PDI type into the EEPROM: 
 

1.  After starting up the TwinCAT software in section 4.1, the screen should look something like the 
screenshot shown below.  Double-clicking the EtherCAT slave (labelled “Box 1” in the figure) 
brings up the EtherCAT properties window on the right.  Click “Advanced Settings”. 

 
 

Figure 23. TwinCAT Project EtherCAT Tab 
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2. In the advanced settings popup windows, select “Smart View” to bring up detailed information 
about the EtherCAT Slave PDI.  Click “Write E2PROM”.  Note that, prior to initialization, this view 
shows a “blank” configuration. 

 

Figure 24. TwinCAT "Smart View" Slave properties Window showing Blank Slave 
 

3. Click “Browse” to find the desired EEPROM binary associated with either the SPI or EMIF 
interface in the sw/master_files directory downloaded from the project site. 

a. pdi_test_app_spi.bin  - for SPI interface 
b. pdi_test_app_emif.bin – for EMIF interface 
c. Click “OK”. 

 

 
Figure 25. TwinCAT3 EEPROM File Dialog 
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4. After TwinCAT writes the EEPROM (in this case for the SPI), the following  “Smart View” window 
showing a valid configuration with PDI Type = “SPI slave” should appear. 

 
 

Figure 26. TwinCAT "Smart View" Slave properties Window showing programmed EEPROM 

 
 

The EtherCAT Slave controller is now prepared for communication to the MCU. 
 
 
  



 
www.ti.com 

 

 TIDUBQ6 - April 2016 EtherCAT® Interface for High Performance C2000™ MCU 21 
 

Copyright © 2016, Texas Instruments Incorporated 

 

5 Getting Started Firmware 

A software package (project pdi_hal_test_app) is included with this TI Design that contains a Code 
Composer Studio (CCS)  project designed for the ‘F2837x. The project should be imported into CCS v6.0 or 
later for building and uploading to the target board.  Six build configurations are provided to enable use 
of RAM or Flash-based designs with two board types (ControlCARD and LaunchPad) and two PDI types 
(EMIF and SPI). 
 
NOTE for EtherCAT Developers: 
The EtherCAT Technology Group (ETG) recommends membership for parties implementing EtherCAT in a 
machine or machine line.  Please see the following links for additional information about EtherCAT and 
ETG membership: 

 EtherCAT FAQs: https://www.ethercat.org/en/faq.html 

 EtherCAT Technology Group site: https://www.ethercat.org 
 

5.1 PDI Test project CCS setup (project import) 

 
The PDI test application contains a Hardware Abstraction Layer (HAL) which handles all of the 
configuration details for the EMIF or SPI interface.   This CCS6.x project also performs some simple 
Read/Write tests to verify correct functioning of communication with the ET1100 Slave controller.  
 
The CCS project files for pdi_hal_test_app can be downloaded from the design directory at 
http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT.  Once downloaded, import this project into CCS 6.0 
or later using the procedure below: 
 

1. File -> Import…  (an “Import” popup window appears) 
2. Select “Code Composer Studio” -> CCS  Projects. Click “Next”. 
3. Use “Select search-directory”  and click “Browse” to find the pdi_hal_test_app source directory. 
4. Select pdi_hal_test_app from the list of Discovered projects. 

a. Leave the “Automatically import referenced projects” box checked. 
b. Checking the box for “Copy projects into workspace” is optional. 
c. Click “Finish”.  The CCS project will appear in the project explorer window. 

  

https://www.ethercat.org/en/faq.html
http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
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6 Test Setup 

The main purpose of this test is to demonstrate the usage of the PDI (Process Data Interface) between 
the C28x processor and the ET1100 EtherCAT Slave Controller.  The EtherCAT board is available as both a 
piggyback board for the F2837x controlCARD and a BoosterPack for use with TI LaunchPads.  Both boards 
have identical hardware and differ only in the connectors used to attach them to their respective 
proccessor board. 
 
 

 
 

Figure 27. EtherCAT BoosterPack Test Setup 
 

The test setup in Figure 27 shows a C2000 LaunchPad with attached EtherCAT BoosterPack and two PCs.  
The left PC connects to the BoosterPack through a standard Ethernet cable connected to Port 0, and runs 
TwinCAT 3 software, which provides EtherCAT Master functionality.  The right PC connects to the 
LaunchPad directly through the USB connector and runs the EtherCAT Hardware abstraction layer (HAL) 
software on the CCS6.x development environment.  The HAL software in this example performs the 
following functions: 
 

1. Initialize the C28x hardware and the selected PDI interface (SPI or EMIF) 
2. Execute read/writes to the ET1100 User RAM 
3. Execute reads from ET1100 register space. 
 
The intent of this project is to demonstrate the usage of the PDI (Process Data Interface). Therefore, 
no EtherCAT stack is included in this demo.  

 
Note that the HAL software supports both the SPI and EMIF as PDI interfaces. The user must choose the 
proper settings when building the project. Correct jumper settings on the BoosterPack are also required 
for proper operation.  These settings are described in section 4.2 
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6.1 Running simple ESC interface test on C28x 

 
After downloading the software from the project directory at http://www.ti.com/tool/TIDM-DELFINO-
ETHERCAT, and importing the project into CCS, perform the following steps to exercise the PDI Hardware 
Abstraction Layer. 
 

1. Open the example project pdi_hal_test_app in CCS.  The file pdi_test_appl.c has the main 
routine.  The following code is of interest: 

 
  
 
 
 
 
 
 
 

 
Figure 28. CCS example project: pdi_hal_test_app 

  

ESC_HWInit() Initializes the C28x MCU and the PDI 

ESC_setupPDITestInterface() Set-up PDI interface and initialize test            
variables and ET1100 RAM over PDI 

ESC_debugUpdateESCRegLogs() Keep updating ET1100 registers in a loop. User can 
add to the list of registers to read in the escRegs 
data structure. 

http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
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2. Right click on the project and set the desired active build configuration. The figure belows shows 
the available configurations, which provide options for both LaunchPad and controlCARD board 
types, FLASH and RAM program storage, as well as interface types (EMIF, SPIA,SPIC) .  
 

 
Figure 29. EtherCAT HW abstraction Layer project. 

 
For this example, choose build configuration (6_LAUNCHPAD_SPIA_RAM) by right-clicking on the 
project name and selecting “Build Configuration” -> Set Active -> (6_LAUNCHPAD_SPIA_RAM) 
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Figure 30. CCS Project Build Configuration management 
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Start TwinCAT3 on the EtherCAT Master PC as described in section 4.1.3.  Note that double-
clicking the EtherCAT slave node (“Box 2” in this figure) opens up a properties windows, from 
which the “Advanced Settings window” can be opened. This will be used later in the demo. 
 

 
Figure 31. TwinCAT3 Advanced settings Dialog 

 
3. Start the debugger and open the memory browser window as shown in the figure below.  The 

“escRegs” data array contains a list of ET1100 register addresses and values. These will get 
updated in the ESC_debugUpdateESCRegLogs() function. 

Figure 32. Device Debug memory window at INIT time. 

 
NOTE: The ESC RUN LED will NOT be on during the memory tests described in the following sections.  See 
the ET1100 datasheet   
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ESC RAM READ TEST 
4. Open up the “advanced settings” window in TwinCAT3 and go to the memory browser at  

ESC Access -> Memory and view Start Offset = 1000h as shown in the figure below. 
 

Figure 33. TwinCAT3 Memory Read Window 

 
5. In CCS, view the Expressions window and add “escRegs” as a watched expression. 

Note that, as data is entered into the window in TwinCAT, the values read on the CCS side are 
identical.  

 
 

Figure 34. EtherCAT write to Memory From CCS Project 
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ESC RAM WRITE TEST 
 
6. The following figure shows program control after execution of the first 32-bit write and 32-bit 

read from PDI to ET100 address 0x1000. 

 
Figure 35. CCS Project Write to EtherCAT Slave 

 
7. The TwinCAT Master view of the ESC memory address showing the results of the write from CCS. 

 
 

Figure 36. TwinCAT3 Master read of data written to EtherCAT slave 
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6.2 TwinCAT3 Troubleshooting 

Common issues in TwinCAT3 usage 
1. Problem: EtherCAT network fails to initialize 

 Other Descriptions: “Reload Devices” fails, “Scan” for devices fails,  
“Restart EtherCAT in config mode” fails. 

 Solutions: 
a) Power Cycle the LaunchPad 
b) Check to make sure a RealTime Ethernet Driver is available: 

TwinCAT-> “Show RealTime Ethernet Compatible Devices”.  This will open a popup 
window below.  
- Look for the 1st line “Installed and ready to use devices (realtime capable)”. 
     In this example there are NO adapters installed! 
- Select a compatible device, which here is “Local Area Connection – Intel ….” 
     and click “Install” 
- Close the window by clicking “X” in the upper right corner. 
 

 
Figure 37. TwinCAT3 Ethernet Adapter installation 
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7 Design Files 

7.1 Schematics 

To download the Schematics for each board, see the design files at http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT. 
 

http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
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Figure 38. LaunchPad and Hi-Density Connector schematics. 
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Figure 39. ET1100 EtherCAT Slave Controller schematics 
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Figure 40. Ethernet PHY schematics- Port 0 
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Figure 41. Ethernet PHY schematics- Port 1
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7.2 Bill of Materials 

 
To download the Bill of Materials for each board, see the design files at http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT 

 
Table 3: Bill of Materials for EtherCAT Adapter Board 

Item Qty Reference Value Part Description Manufacturer 
Manufacturer  
Part Number 

PCB Footprint 

1 1     PWB,C2000-ET1100 ADAPTER BOARD       

2 1     LOGIC,C2000-ET1100 ADAPTER BOARD       

3 1 U5   
IC,BGA128,.8mm,ETHERCAT SLAVE 
CONTROLLER Beckhoff ET1100 bga128-8mm 

4 2 U3, U6   
IC,QFN32,SINGLE PORT 10/100Mbs ETHERNET 
PHY TRANSCEIVER,LOW POWER Texas Instruments TLK105LRHBR QFN32_202SQ 

5 1 U7   
IC,QSOP16,LOW VOLTAGE,QUAD 2:1 
MULTIPLEXER/DEMULTIPLEXER Texas Instruments SN74CBTLV3257PWR tssop16-14x70 

6 1 U2   IC,QSOP20,LOW VOLTAGE,QUICK SWITCH Texas Instruments SN74CBTLV3245ADBQR dbq20-14x70 

7 1 U1   IC,SO5,SINGLE BUFFER/DRIVER Texas Instruments SN74LVC1G07DCKR dck-5 

8 1 U4 16k IC,SO8,SERIAL EEPROM,16K-BIT Catalyst Semiconductor CAT24C16WI-GT3 so8-25x75-295 

9 1 U8 3.3v,1.6A 
IC,SON8,STEP-DOWN DC-DC 
CONVERTER,1.6A,3.3V Texas Instruments TPS62063DSGT dsg8-11x20 

10 1 Y1 25MHz CRYSTAL,SMT,4 PIN,25MHz ECS ECS-250-20-33-TR xtal4-47x51-ecx32 

11 2 DS1, DS2 Green LED,SMT 1206,GREEN LITEON LTST-C150GKT led1206-59x59 

12 1 L2 1uH INDUCTOR,SMT,1uH Murata Electronics LQH44PN1R0NP0L ind-LQH44p 

13 1 L1 220ohm FERRITE BEAD,SMT 0603,220 OHM Murata Electronics BLM18AG221SN1D l603-35x45 

14 2 C41, C83 4700pF 
CAP,CER,SMT 1206,4700pF,200V,+10/-
10%,X7R AVX Corporation 12062C472KAT2A C1206-40X70 

15 2 C4, C6 22uF CAP,CER,SMT 1206,22uF,10V Taiyo Yuden LMK316F226ZL-T C1206-40X70 

16 8 
C12, C14, C15, C33, 
C55, C58, C77, C82 1uF CAP,CER,SMT 0603,1uF,6.3V,X5R,+/-10% Murata Electronics GRM188R60J105KA01D c603-35x45 

17 8 C22, C26, C34, C38, 10uF CAP,CER,SMT 0603,10uF,6.3V,X5R,+/-20% Murata Electronics GRM188R60J106ME47D c603-35x45 

http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
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C44, C74, C78, C80 

18 15 

C2, C27, C28, C30, C31, 
C43, C46, C49, C52, 
C57, C63, C64, C66, 
C67, C81 220pF CAP,CER,SMT 0402,220pF,50V,NPO Panasonic ECJ-0EC1H221J c402-25 

19 2 C3, C7 15pF CAP,CER,SMT 0402,15pF,50V,NPO Yageo CC0402JRNPO9BN150 c402-25 

20 2 C1, C37 100pF CAP,CER,SMT 0402,100pF,50V,+/-5%,NPO Kemet Electronics Corporation C0402C101J5GAC c402-25 

21 5 C8, C25, C32, C73, C76 1000pF CAP,CER,SMT 0402,1000pF,50V,+/-5%,NPO TDK Corporation CGJ2B2C0G1H102J c402-25 

22 35 

C5, C9, C10, C11, C13, 
C16, C17, C19, C20, 
C21, C23, C29, C35, 
C36, C39, C40, C42, 
C45, C47, C48, C50, 
C51, C53, C54, C56, 
C59, C60, C62, C65, 
C68, C69, C70, C71, 
C75, C79 0.1uF,16V 

CAP,CER,SMT 0402,.1uF,16V,+/-
10%,X7R,AUTOMOTIVE Murata Electronics GCM155R71C104KA55 c402-25 

23 4 C18, C24, C61, C72 0.01uF CAP,CER,SMT 0402,.01uF,16V,+/-10%,X7R Kemet Electronics Corporation C0402C103K4RAC c402-25 

24 18 

R15, R16, R17, R22, 
R30, R32, R36, R37, 
R41, R48, R49, R50, 
R52, R54, R57, R62, 
R63, R69 2.2kohm RES,SMT 0201,2.2K OHM,5%,1/20 WATT Yageo RC0201JR-072K2L r201-6p6spc 

25 2 RJ1, RJ2 0 ohm RES,SMT 0402,0 OHM,1/16 WATT Yageo RC0402JR-070RL r402-25 

26 2 R1, R8 10kohm RES,SMT 0402,10K,1%,1/16 WATT Yageo RC0402FR-0710KL r402-25 

27 1 R19 11kohm RES,SMT 0402,11K OHM,1%,1/16 WATT Panasonic ERJ-2RKF1102X r402-25 

28 20 

R13, R18, R20, R24, 
R25, R26, R27, R28, 
R33, R34, R42, R44, 
R45, R46, R47, R59, 
R66, R67, R68, R73 4.7kohm RES,SMT 0402,4.7K,1%,1/16 WATT Vishay Intertechnology CRCW04024K70FKED r402-25 

29 2 R40, R65 4.87kohm RES,SMT 0402,4.87K,1%,1/16 WATT Panasonic ERJ-2RKF4871X r402-25 
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30 14 

R2, R3, R4, R5, R6, R7, 
R9, R10, R11, R12, R39, 
R58, R70, R71 49.9ohm RES,SMT 0402,49.9 OHM,1%,1/16 WATT Panasonic ERJ-2RKF49R9X r402-25 

31 6 
R14, R43, R51, R72, 
R74, R75 470ohm RES,SMT 0603,470 OHM,5%,1/16 WATT Panasonic ERJ-3GEYJ471V r603-35X45 

32 1 SW1   SWITCH,DIP,SMT,HALF-PITCH,2 POS. C&K/Unimax, Inc. TDA02H0SB1R sw2-30x50-tda 

33 1 J6   
CONN,SMT,RECEPTACLE,60 POS.,.4mm 
SPC.,4mm STACKING HEIGHT Hirose Electric, Inc. DF40HC-(4.0)60DS-0.4V df40c_60ds 

34 2 P1, P0   
CONN,JACK,RJ45,INTEGRATED MAGNETICS 
AND LED'S,8 CONTACTS,SHIELDED Pulse Engineering J1011F01PNL RJ45-PULSE_J1-SHLD 

35 2 J3, J10   HEADER,3 X 1,VERTICAL,2mm Harwin M22-2510305 hdr1x3-6040-2mm 

36 1 TP15   TEST POINT,SMT,MINIATURE Keystone Electronics Corp. 5015 TP1-70X135 

37 10 

TP2, TP3, TP4, TP5, 
TP6, TP7, TP9, TP11, 
TP13, TP14   ( NO-POP ) TEST POINT,SMT,.03" DIA.     tp30 

38 10 

R23, R29, R31, R35, 
R38, R53, R55, R56, 
R61, R64         r201-6p6spc 

39 2 R21, R60         r402-25 

40 5 
TP1, TP8, TP10, TP12, 
TP16           

41 1 J9   CONN,HEADER,SHROUDED,2 POS JST Corporation B2B-EH-A(LF)(SN conn2-eh 
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7.2.1 Layout Prints 

To download the Layout Prints for each board, seTIDM-DELFINO-ETHERCATe the design files at 
http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT 
 

TOP SILKSCREEN 

 
Figure 42: Layout-Top Silkscreen 

 
TOP SOLDER MASK 

 
Figure 43: Layout- Top Solder Mask 

 
TOP LAYER 

 
Figure 44: Layout- Top   
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GROUND PLANE LAYER 2 

 
Figure 45: Layout- Ground Plane L2 

 
BOTTOM LAYER 

 
Figure 46: Layout- Bottom layer 

 
BOTTOM SOLDER MASK 

 
Figure 47: Layout- Bottom solder mask 

 
BOTTOM SILKSCREEN 



 
www.ti.com 

 

 TIDUBQ6 - April 2016 EtherCAT® Interface for High Performance C2000™ MCU 40 
 

Copyright © 2016, Texas Instruments Incorporated 

 

 
Figure 48: Layout- Bottom Silkscreen 

 
 

MECHANICAL DIMENSIONS 

 
Figure 49: Layout- Physical Dimensions 
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7.3 Orcad Project 

To download the Orcad project files for each board, see the design files at http://www.ti.com/tool/TIDM-
DELFINO-ETHERCAT 

7.4 Gerber files 

To download the Gerber files for each board, see the design files at http://www.ti.com/tool/TIDM-DELFINO-
ETHERCAT 

7.5 Assembly Drawings 

To download the Assembly Drawings for each board, see the design files at http://www.ti.com/tool/TIDM-
DELFINO-ETHERCAT 

8 Software Files 

To download the software files for this reference design, please see the link at http://www.ti.com/tool/TIDM-
DELFINO-ETHERCAT 

9 References 

 
1. LAUNCHXL-F28377S – C2000 Delfino MCU F28377S LaunchPad Development kit 
2. TMDXDOCK28377D – F28377D Delfino MCU Experimenter Kit 
3. Code Composer Studio (CCS) Integrated Development Environment (IDE) 
4. Texas Instruments E2E™ online community, http://e2e.ti.com/ 

10 Terminology 

 EMIF: External Memory Interface 

 ESC: EtherCAT Slave Controller 

 ETG™: EtherCAT Technology Group 

 LaunchPad: An easy-to-use development tool intended for MCU-based applications. 

 MCU: MicroController  

 PDI: Process Data Interface 

 SPI: Serial Peripheral Interface 
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